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Introduction

TS2 sets a new industry standard as an audio editor by ircamLAB for audio transformations 
and enhancement. It offers a comprehensive suite of processing tools focused on the 
acclaimed “SuperVP” engine to manage complex audio issues with unparalleled accuracy.


Post-Production professionals, audio engineers, and podcast editors alike use TS2 to 
transform recordings in to a final production file. This user guide provides an extensive 
overview of quick access authorization and setup, and all the application features and 
functions. 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ircamLAB TS2 (version 2.2)


1. Requirements





"


OS macOS 10.10 or later

CPU Intel 64 bit

RAM 8GB or high recommended

Display 1024x768 or higher

Formats 64 bit: Standalone

OS Windows 7 or later

CPU Intel/AMD CPU with SSE2

RAM 8GB or higher recommended

Display 1024x768 or higher

Formats 64 bit: Standalone
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2. Authorization


Upon launching the application you will be presented with the authorization screen…




Here you may proceed to run the application in demo mode with restrictions (noted below), 
enter your serial number provided in your purchase order receipt, or visit Plugivery Distribution 
for listed dealers to purchase from.


Selecting to Authorize will open the following window (also available from the TS menu > 
Authorize)…


Once you have entered your serial number, the application will now be authorized for use.
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Purchase provides authorization for up-to 3 computers, and you may deauthorize a computer 
at any time from the Authorization window…
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3. Feature Comparison


FEATURES TS2 TS

Transpose & Stretching X X

Remix X X

Spectral Clipping X

Real-Time Recording X X

Full Audio Editing & Crossfade X

Automation X

MIDI CC Assignable Control X X

Real-Time Sonogram X

Multiple Audio Files & Regions X

Multichannel Audio Formats X

Multiple Work Documents X

Cut, Copy, & Paste X

VST/AU Plug-in Hosting X

Volume, Pan, Mid/Side X Volume Only

Command Line Export X
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4. Interface Overview
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The TS interface is comprised of 6 main sections (Transport, Panels Selector, Audio Sequencer, 
Sonogram View, Automation View, and Selector Display).


Transport 
This section displays general transport controls (RTZ, Play/Pause, Fast-Forward, Loop 
Playback, Record), editing of Playhead time position and Region time placement values, and 
provides a cursor overview for Time (Audio Sequencer view), Frequency, MIDI and Amplitude 
(Sonogram view), and Automation values (Automation view).




Record 

Is operated in conjunction with Play, to arm and proceed to record the live session. Once the 
recording ends, a dialog window prompts to save the recording on the disk.


Loop Playback 

Select an audio region or make a selection and press this button to settle loop start and end 
points.  You may adjust these either from the Start and End time display values or whilst 
holding the Shift modifier key and drawing the blue area to change start and end points as 
wished.


Playhead Indicators


The solid RED vertical line overlaid on the Waveform and Sonogram indicates the current 
playhead position. This indicator line updates to follow the current playhead position during 
playback.


The playhead position indicator will only appear in the audio sequencer window when it is 
within the bounds of the current selection.


Playhead Anchor 

The solid BLUE vertical line overlaid on the Waveform and Spectrogram, Ruler, Loop Selection 
and Automation indicates the playhead start position in the Time Ruler window.
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Panel Selectors 
On the left-hand side, are your panel selectors. These open the respective panels to show 

parameters for the Sonogram, Effects such as time stretch and transposition, Automation, and 
Master panel (such; adding VST/AU plug-ins and metering).


Audio Sequencer 
Displays audio tracks for editing (cut, copy, paste, fade/crossfade, etc.).


Sonogram View 
Displays the sonogram. A 3D visual representation of your audio source. Time (x axis), 
Frequency (y axis), and Amplitude (represented by the colour).


Automation View 
Displays automation for applying real-time automatons to your tracks, such as transposing.
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Selector Display 
This section displays options for selecting audio channels for view, the section view selectors 
for opening the main edit and view panes (Audio Sequencer, Sonogram View, Automation 
View), CPU display, and toggle options for selecting MIDI Learn, and both Ripple and Snap 
audio region features…


MIDI 
Toggles MIDI Learn on/off for select parameters available in the Effects and Master panels.


Select a highlighted BLUE parameter to turn GREEN, and with your controller adjust a knob/
fader to assign it a MIDI CC value for control.


Right click on the knob/fader to display a dropdown menu with the MIDI mapping information 
and the possibility to remove the connection.


You may also show the MIDI MAP window for an overview of all assignments…
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Snap 
Activate or deactivate the magnetism between regions when moving them.


From TS2 Menu, select Edit… >  Snap Mode, or click the button for toggling on/off.


Ripple 
Shift all the regions after the playhead position to the right when inserting new regions, and to 
the left when deleting regions. 


From TS2 Menu, select Edit… >  Mode Ripple, or click the button for toggling on/off.


Audio Settings Window 

The Audio Settings Window (accessed from the application’s menu) allows for setting your 
audio preferences, such as Driver, Output Device, Buffer Size and Sample Rate.  It also 
provides channel routing for multi-output audio interfaces…


Stereo Limitation 

For backward compatibility with documents created with previous versions of the TS2 
application, you can choose to force the application into stereo format compatibility mode with 
the stereo limitation option.
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When the stereo limitation is active, only the first two channels of the audio regions are 
processed by the application.  In this case, the meters only show the first two channels (and 
only the first two channels are accessible on the channel routing option).

 

* You can still import multichannel audio files into the document, and all channels are still 
shown in the waveform and sonogram panel.


Channel Routing 
A maximum of 4 channels are displayed in the routing option at the same time for visibility.  In 
case of more than 4 channel audio regions, you can scroll between all the channels using the 
scroll bar at the left of the routing option. 


ircamLAB TS2 Manual — 11



5. Working with Documents

Upon launching the application for the first time (default state), you will be presented with this 
screen…




Here you may click to Load a previously created Document, load audio files, or drag/drop 
audio files to the interface to create a new Document. Multiple documents may be loaded in 
the application.


Drag and drop or clicking the Load button prompts a dialogue window to open previously 
created documents and/or audio files.


Open Documents

TS2 supports opening unlimited documents. Documents may be opened from the initial load 
screen, File menu, or via the applicable shortcut shown in the Appendix at the end of the 
manual.


Create New Document 
To create a new document in TS2 you may use the File menu, shortcut, or click the “+” icon to 
the top left of the screen (underneath the Transport pane).
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Save & Save As Document 
Save and Save As operations are available from the File menu and typical application modifier 
shortcuts detailed in the key commands appendix.


Consolidate Documents 
This option found in the in the File menu allows for the export of all audio files & TS2 
documents within your session.


This process will ask you to save any unnamed documents and consolidate all audio files from 
the current document into a directory folder, placing that next to your saved document file.


Close Document 
To close a document in TS2 us the following methods:


1. Open the File menu and select “Close document”.


2. Single-click on the ‘X’ button in the file tab display.




Export Audio 

To export your audio from the selected Document, you may 
chose File > Export.


This option opens the following window where you may set a 
Time range, either:


Global - for the entire session.


Selection - for your selected region(s) or selected audio.


Custom - for selecting a custom range for export. This 
requires you enter values for Start, End, or Length and “press 
enter” for the Time Range to change to Custom.


The Export Audio window also allows you to select your Bit 
Depth (8bit-32bit), Sample Rate* (44.1kHz-192kHz), and whether 
you wish to automatically open your exported audio in a new 
document.


Audio file type format is selectable for WAV, AIFF, FLAC, and 
Ogg-vorbis.
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With the “Separate mono audio files” option activated, each channel is exported to a separate 
mono audio file (the channel number is appended to the name of each audio file).


If stereo limitation is selected on the audio settings, only the first 2 channels are processed  by 
the audio export. 


* Default export settings are 48kHz, 24-bit (WAV). 
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6. Sonogram / Waveform Views 

Overview 
TS2 provides 3 separate views : Waveform, Sonogram and Automation. You can select them 
by clicking on the respective icons (Selector Display).




The sonogram allows you to visualize the amplitude information in the frequency domain of an 
audio recording over time.


The waveform allows you to visualize the signal amplitude information of an audio recording 
over time.
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TS2 features a rich visual environment for editing and visualizing audio. The central focus of the 
interface is the Sonogram and the Waveform.


Adjust the vertical window size, view channels (L+R), Sonogram type and energy range value in 
the lower contextual menu.

 


Sonogram Settings


Energy Color 

The amplitude of frequency content (energy) is indicated by variations in color in the 
Sonogram.


The color fader (to the left in the lower tab display) shows the color being used to represent a 
given amplitude value (-120dB to 0dB).


You can change the Visual aspect by selecting in the color menu and one of the 3 options 
(Rainbow, B/W or Hot).


Settings 

The TS2 Sonogram is highly configurable, you can adjust the default configuration, load a 
preset or save your own preset in the Sonogram Menu.


The Sonogram Settings window can be opened from the “Menus Selector” display on the left 
of TS2, clicking on the Sonogram icon.


Sonogram Analysis Type 

TS2 offers different methods for displaying the Sonogram. TS2’s advanced Real-Time 
Sonogram modes allow you to see sharper time (horizontal) and frequency (vertical) resolution 
simultaneously.


Menu content : FFT - LPC - True Env - Reassigned Spectrum 


Window Size 

The greater the FFT size, the greater the frequency resolution.


Choosing a larger number here will make time events less sharply defined because of the way 
this type of processing is done. 
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Frequency Scale 

Using different frequency scales can help you see useful information more easily.


Different scales have different characteristics for displaying the vertical (frequency) information 
in the Sonogram display.


Rulers 

Right-clicking on the frequency ruler will zoom the frequency scale.


You may select the following options in the Sonogram Menu…


Linear: 
 
Linear scale means that Hertz are linearly spaced on a screen. 0Hz to Nyquist 
frequency.


Log: 

In this mode, different octaves occupy equal screen space.


Spectral Clipping Preview  

The spectral clipping preview option allows the visualization of the spectral clipping effect in 
the frequency domain.


As the spectral clipping filter is a complex frequency domain effect, the preview facilitates the 
understanding and control of the parameters.


	 


	 


Frequency Scale Type Descripton

Linear Displays frequencies spread out in a uniform way. This is most 
useful when you want to analyze higher frequencies.

Logarithmic This scale puts more attention on lower frequencies.
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Save & Load Snapshot Setting 

You can save individual sonogram setup and be able to reload for comparison.


Waveform Display 
The single stereo waveform drawn in the window represents all audio files present in the 
current document. The waveform drawing is normalized to allow for consistent vertical 
resolution when working with selections of varying amplitude.


Sonograms 
Sonograms are visual representations of the spectral contents of a sound : the distribution of 
the signal energy over frequency, and how this energy distribution evolves in time.


This section gives an overview of the various types of sonograms available in TS2.


Sonograms include 2 types of time/frequency representations:


1. Representations of the temporal evolution, (FFT, Reassigned Spectrum) of the frequency 
and amplitude of the energy of all components – sinusoids and noise – of the signal.


2. Temporal representations of the spectral envelope of the signal (LPC, True Envelope, 
Discrete Cepstrum). The spectral envelope is a representation that characterises the 
spectral color of the signal. In other words it is a rough characterises the rough energy 
distribution neglecting details of individual sinusoidal components or noise.


Analysis Types: 

FFT (Fast Fourier Transform) 

The Fast Fourier Transform decomposes the spectrum into a sum of short sections of 
windowed sinusoids, and represents the distribution of the energy over these components. 
Energy variations are represented with a contrast scale.


Reassigned Spectrum 

The energy distribution in the spectrum is also calculated with an FFT, but the energy of the 
individual sinusoidal components, as well as that of the transients is reassigned to increase the 
frequency and time resolution. The reassigned spectrogram is especially suited for precise 
analysis of sinusoidal components and transients.
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LPC (Linear Predictive Coding) 

The LPC analysis is related to a source-filter model of speech signals. It estimates the filter of a 
source filter model using an auto regressive filter with a filter order specified by the user. The 
filter is then displayed as a spectral envelope. This set of coefficients is a simplified 
representation of the resonator filter of the sound producing system, notably the vocal tract 
filter for speech.


The LPC analysis has been widely used for speech analysis but it is well know that it is well 
suited only for analysis of unvoiced or noise signals. For these kind of signals, the LPC analysis 
reveals the correct filter whenever the filter order is sufficiently high (LPC Order).


If applied to voiced signals and even if the correct filter order is specified the LPC analysis 
generally suffers from systematic errors and the True Envelope method discussed below 
should be preferred.


True Envelope


The true envelope analysis is one of the most efficient spectral envelope estimation techniques. 
It is designed to improve the results of the LPC. The main advantage is the fact that an 
appropriate order of the True Envelope analysis can be derived from the fundamental frequency 
of the sound signal. The true envelope analysis will neglect spectral details with precision 
smaller then the given max frequency.


Accordingly, the true envelope order is parameterized by the maximum fundamental frequency 
of a given sound signal. To improve the precision, the can setup the time varying fundamental 
frequency of a sound signal (Max Fund. Freq) that will then provide optimal analysis resolution.


SuperVP 
Window Size 

Sets the window size in samples for the analysis.


Window Duration 

Sets the duration in ms/sec for the analysis. 

Fundamental 

Sets the optimal fundamental frequency for the analysis.


Window Type 

Click to set the window type for analysis.  Provided window types for analysis may be reviewed 
here - https://en.wikipedia.org/wiki/Window_function
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Window Overlapping 

Change the window overlapping of the analysis.


FFT Oversampling 

Change the FFT Oversampling of the analysis.


FFT Size 

Displays the size of the FFT in samples.


Frequency Band 

Displays the size of the frequency band in Hertz. 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7. Working with Audio Files


Overview 
The Audio sequencer window includes all the tools for managing & editing audio files.


Supported Audio File Formats 
The following audio file formats can be opened in the TS2:

 

AAC, AIFF/AIF, FLAC, M4A, MP3, OGG, WAV, WMA.


Supported Channel Configurations: 

TS2 supports Mono, Stereo and multichannel (up to 256 channels) audio files. Mono files will 
be automatically converted into stereo on import.


With TS2.2 and above you may edit and transform different types of multichannel audio files 
within the same document.  


The organization of audio channels for imported audio files is preserved by the application.


There is no automatic distinction between channels (for example; no distinction of an LFE 
channel that will be processed as any other channel).


In the lower tabbed section of the interface you can select which channels are displayed on the 
waveform and the sonogram views. You can visually disable one channel by single clicking on 
a channel selector. 
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Import Audio Files 
There are numerous ways to import audio in TS2, from menu operation to drag/drop support.


Note: Mono audio files are converted to stereo on import.


The Import Operations include:


	 	 1. Open the Edit menu and select Import Region(s).


	 	 	 Shortcuts: Command + I (Mac) or Ctrl + I (Windows).


	 	 2. Drag and drop an audio file in the Track window.


	 	 3. Import to a specific timeline position by clicking on the desired time in the waveform 
window and insert your audio file.


	 	 	 Shortcuts: Command+I (Mac) or Ctrl+I (Windows).


You can import unlimited audio files at once with the same functions.


Create a Region 
There are different ways to create an audio region in the waveform window.


	 1. Create a time selection on the waveform, click CMD + E (Mac) or CTRL + E 
(Windows), or Menu > Edit, and select Split region.


	 2. Set the Start & End values in the Time Display and perform the key command action 
to create the new region, or go to Menu > Edit, and select Split region.


	 3. Create a region from a loop : (ALT + Click on the loop tab) then use the respective 
key command above to create a region.


You can move, copy, paste and delete any regions.
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Zoom Tools 
You can only zoom horizontally on the Waveform views, but horizontally and vertically in the 
Sonogram and Automation windows.


The following zoom selection tools are available in TS2:


Time Slider 
The horizontal slider in the lower part of the Sonogram display controls the zoom level of the 
time ruler.


Time Selection Tools 
The time selection tool selects a range of time within the file (horizontally within the waveform 
window).


There are a number of ways to create a time selection in the TS2:


	 1. Select a range of time within the file on the waveform window.


	 2. Set the Start and End time in the time readout display.


	 3. By clicking in real time on :  I for start point & O for end point.


Function Command Description

Zoom In
CMD + = (Mac)


CTRL + = (Windows)

Zooms in on the time ruler by 
clicking & sliding vertically.

Zoom Out
CMD + - (Mac)


CTRL + - (Windows)

Zooms out on the time ruler by

click & slide vertically

Zoom to Selection
CMD + Click + Drag (Mac)


Ctrl + Click + Drag (Win) 
Zooms to fill the selection by


the Time Ruler.

Zoom to Whole File Double Click Resets zoom time to default.

Shift the Zoom SHIFT + Click + Drag Shifts the zooms range while 
preserving the zoom factor.
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Drag Tools 
When zoomed in on an area, the Drag Tool can be used to move Audio Regions through the 
time range by clicking and dragging your region along the time ruler. Or, by SHIFT + Clicking 
and dragging the slider in the lower part of the Sonogram display.


Fade & CrossFade Tools 
Fade handles to the side of each region can be used to apply a gradual increase or decrease to 
gain.


A constant power fade type is available only at this time.


	 1. Create a fade by moving the yellow circle nodes (top left) on the region for Fade In 
and (top right) for Fade Out.


	 2. To create a crossfade you need two separates actions:


	 	 Create a Fade In on the selected region.


	 	 Drag the selected region on to the previous audio file to create the crossfade.


	 	 Crossfades must be between 2 separate regions, A & B. 


	 	 The Fade In should be done on the region “B” to initiate the crossfade.


	 	 Crossfade in & out points are adjustable separately using the yellow circle 
nodes.
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8. Edit Functions


Undo / Redo 
TS2 includes an unlimited undo & redo list.


Additional Functions 
TS2 includes the following Editing functions:


Function Command Description

Insert
CMD + I (Mac)


CTRL + I (Windows)
Insert an audio file at a specific time value 

set by the playhead position.

Delete Backspace Deletes selected audio files and 
automation node points.

Cut
CMD + X (Mac)


CTRL + X (Windows)
Removes the currently selected audio and 

stores it temporarily in the clipboard.

Copy
CMD + C (Mac)


CTRL + C (Windows)

Makes a copy of the currently selected 
audio or automation node to the 

Clipboard.

Paste
CMD + V (Mac)


CTRL + V (Windows)

Places audio or automation nodes that 
have been stored in the Clipboard at the 

current playhead point.

Split
CMD + E (Mac)


CTRL + E (Windows)

1. You can create a new audio file 
region from a selection or at the 
play cursor position.


2. For automaton, you can add start 
and end point nodes for a 
selection.


Note: You’ll need to make a selection in 
the automation track lane.

Train Regions
CMD + T (Mac)


CTRL + T (Windows)
Removes silence between selected regions
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9. Select Regions / Navigation

There are multiple different ways to select regions, as:





Function Command Description

Select All
CMD + A (Mac)


CTRL + A (Windows)
Selects all region in the timeline.

Select Multiple Regions SHIFT + Click a Region Select multiple regions.

Click Select Use Left/Right keyboard arrows 
and hold SHIFT + Left/Right

Holding SHIFT and using the 
Left or Right keyboard arrows 

will select a region up-to its start 
or end bounds.
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Function Command Description

Undo
CMD + Z (Mac)


CTRL + Z (Windows)

Undoes the last

performed action.

Redo
CMD + SHIFT + Z (Mac)


CTRL + SHIFT + Z (Windows)

Redoes the last

performed action.



Region Properties / Contextual Menu 

Right clicking in the Audio Sequencer will display a contextual menu with multiple functions 
such as undo/redo, insert region, cut, copy, paste, among others, and Region Properties. 


Selecting an audio region and selecting Region Properties will display a window showing said 
regions properties (Position, Start, End, Gain, and Fades).


In this window you may click the audio file name and replace the audio (in place) in the 
timeline. It will essentially spot the audio to the same position and length.  You may then adjust 
the region bounds if you wish from a longer audio file if inserted.
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10. Working with Effects


The Effects panel uses the SuperVP™ audio processing algorithm, to allow for independent 
control over the length and pitch of your audio. It is useful for transposing or stretching audio 
to fit in a mix better.
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SuperVP 
SuperVP™ is a world-class time-stretching and pitch-shifting algorithm. You can easily change 
the pitch of a single instrument, voice, or entire ensemble while preserving the timing and 
acoustic space of the original recording. 


SuperVP is designed to preserve the natural timbral qualities of the original file, even when 
applying extreme pitch shifts or Stretching Fx.


You can adjust the SuperVP engine to fix the treatment quality of your rendering, Save & Load 
the SuperVP Command Line in the SuperVP menu in the « Effects » window.


Transposition 
Controls the amount of pitch-shifting up or down that will be applied to the audio.


The range is fixed to +/- 2400 cents (2 octaves).


Formant 
Formants are the resonant frequency components of sounds.


You can shift formants independently of pitch and time with a fixed range of +/- 2400 cents (2 
octaves).


Typically you will leave the Formant Shift Strength set to 0 (full strength).


If you hear what sounds like an EQ adjustment to your audio, you can try changing the value to 
reduce this artefact.


To achieve special effects, for example to change the perceived gender of a human voice, try 
adjusting the formant to a value close than 0.


Stretch 
Determines how much the resulting audio will be stretched in time.


	 -	 Values between 0.25x and 1x will cause the audio to speed up without affecting pitch, 
resulting in a shorter audio file.


	 -	 Values between 1x and 10x will cause the audio to slow down without affecting pitch, 
giving you a longer audio file.


	 -	 An “Extra Stretch” option available via a radio button to increase stretch to up-to 100x
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Tempo Calculator 
The “To” and “From” Tempo fields allow you to calculate or 
set a target tempo, to speed up or slow down audio in your 
document.


Clicking on the From Tempo text or BPM will open the 
Tempo Calculator.


Here, you may enter the source tempo or calculate it and 
apply the desired tempo change to the document by 
defining the number of beats for your audio selection.


Link  

You can link 2 kind of functions:


	 1. Formant and Transposition, for a different treatment of the sounds.

	 2. Tape mode for simulating a tape speed action.


Max Fundamental Frequency

Lets you adjust the Fundamental Frequency of your region. 800 Hz is set as the default value.


Remix 
Ircam have created a module to separate the Audio content. It is divided into 3 components 
(range 0 - 100%):


	 1.  Sinus

	 2.  Noise

	 3.  Transient 


Remix Settings 

You can adjust the error level to fix the level separation of each process.


Transient release adjusts the release time of the transient process.
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Spectral Clipping  

Spectral clipping is a dynamic filtering effect that performs an energy clipping process on the 
signal, retaining the spectral component corresponding to a specified energy range.  This 
energy range is defined by a minimum and a maximum value in decibels.


Any spectral component with an energy below the minimum threshold is muted and the energy 
of the spectral components is clipped by the maximum threshold.


The spectral clipping effect is a creative tool, between a distortion and a musical filter effect, 
experimentation is a good way to discover the new sonic territories offered by this process (for 
example; on drums, guitars, vocals, etc). 


Range  

The “Range” control is where the user sets the min and the max threshold. It is set on a dB 
scale, -120 dB is the lower limit and 0 dB is the maximum. Only the frequency parts of the 
signal between the min and max setting will pass through the effect. 


Any signal below the Min threshold limit will be filtered as a gate effect. The higher this setting, 
the more low amplitude signal will be filtered.


Any signal over the Max threshold will be clipped as a saturator effect. The lower this setting, 
the more creative saturation will appear. 


Normalization  

As part of the input signal is filtered by the effect, the global amplitude of the output signal can 
be much lower than the original. 


Normalization preserves the energy of the input signal.


The normalization of the spectral clipping filter is ignored by the sonogram preview.
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SuperVP Settings 
Adjust the quality of processing for treatments, and Export audio rendering.


Save & Load SuperVP Snapshot 
You can save & Load various « Effects » snapshots in the file menu of the effects window.


ircamLAB TS2 Manual — 32



11. Working with Automation


The automation window allows for adjustments along two axes: Time and Specific Automation 
Function (for example; for Transposition, the y-axis is a frequency scale).


You can activate the view and automation on/off of each functions.


An Opacity slider lets you see one or more automation lines.


	 VALUE: 	 - The vertical y-axis of the contour curve represents the selected value. 

	 	 	 - The center of the each parameter’s axis equates to default (zero 
crossing point).


	 	 

	 TIME: 		 - The horizontal x-axis represents time. 

	 	    	 - The time format used here is determined by the time format in the 
transport section of the main editor window. 

	 	 - The range of the time ruler matches the length of the current selection.
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Add / Draw Nodes 

Nodes may be drawn in the Automation view simply holding the respective key/command and 
drawing with your mouse.


Remove Nodes 
Individual nodes can be deleted from the curve using the following methods:


	 ⁃	 CTRL (Windows) or Option (Mac) + Click a node to delete it.


	 ⁃	 Make a selection in the automation window to select your nodes, and press 
Delete/Backspace to remove.


	 	 

Reset Curve 
Removes all custom nodes from the curve, resetting it to default.


Two nodes are present in the default curve, one at the start and one at the end of the current 
selection. The default nodes are set to Default values of each parameters.


Function Command Description

Insert Node
CMD + Click (Mac)


CTRL + Click (Windows)

Select your automation curve (from the 
menu panel or by selecting the colour 

points) in the automation window.


Use the key command to add a new node 
to the contour curve.

Move Node Select and Move

Move each node vertically and horizontally 
or double click on nodes to adjust 
manually the Time and Value of the 

automation point in the pop-up window.

Start & End Nodes
CMD + E + Click (Mac)


CTRL + E + Click (Windows)

Make a selection in the Waveform view and 
use the command command to perform the 

action.


New nodes will be placed at the start and end 
points of your selection.
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12. Automation Panel


Overview

The Automation Panel provides access to selecting automation on/off for select curves, and a 
‘Curves Opacity’ which allows the display of all curves in the Automation View.
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Select Curve 

Select the applicable curve by clicking on the automation text name in the automation menu 
window, or by clicking on the multiple colour points in the automation window. Colour points 
are in the same order as the automation menu parameters and you will see their name in the 
Info Text section (bottom left of the UI).

 

Time & Value Adjustment 

Double click on the selected node and adjust the Time and Value in the pop up window on top 
right of the automation window.


Modify Selected Nodes 

You can select nodes by making a selection with the cursor. You have different ways to modify 
your selected nodes:


	 1. Move your selected nodes horizontally or vertically in the timeline.

	 

	 2. Click + SHIFT + move the node, limited to the timeline (x-axis).


	 3. Click + CTRL + move, limited to the vertical amplitude (y-xais).


You can adjust your nodes selection in time and amplitude by clicking on the vertical and 
horizontal edge and side of the container box (you will see you mouse cursor change to an 
arrow to adjust).


Save & Load Individual Curves 

Select the desired parameters and click on Save or Load curve in the FILE automation menu.


Save & Load All Curves 

Lets you save and load all curves at once.
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13. Master Panel


Overview 
TS2’s last process panel includes output functions and metering, and AU/VST plug-in insert 
support.
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Meter 
Metering levels are displayed as peak (red) and rms (blue) in a combined display. 


When the master panel is not detached (as a floating window), a maximum of 5 channels are 
displayed on the meter at the same time for visibility. The user can scroll between all the 
channels using the scroll bar under the meter and also within the meter itself (e.g. with a 
trackpad - swipe). The master panel can be detached and resized to display all the meters at 
once, and clicking the meter area will reset the held peak values.

Right clicking on the VU-meter lets you set your preferences for a minimum and maximum dB 
value. These options only affect the visualization of the meter.


Scale 

The first number is the low end of the meter range, and 
second number is the top end of the metering range.


A small range gives a better precision for loud signals, 
whereas a large range extends the visualization for more 
dynamic audio signals.


Mode 

Toggle between standard channel representation or Mid/
Side.


In case of more than a stereo channel pair, only the first two 
channels (1 and 2) are converted to mid side and displayed.
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Volume Fader 
Lets you adjust the output TS2 level. The fader scale is linked to the fader setting.


Mid/Side 
A progressive parameter control from Mono to Out of Phase (-180).


“OC” is the default value, respecting the true stereo file.


In the case of multichannel audio regions, panning and mid-side effects only affect the first two 
channels, other channels are not affected by these settings.


Features :  
	 Panning - +/- 100 (Left < > Right).


	 Mute - Select this button to mute the output.
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14. Plug-in Section


Supported Formats 
TS2 supports the use of the following plug-in formats in the “Plug-in” panel:


	 	 -	 VST 2 & 3 : Windows and Mac

	 	 -	 AU (AudioUnit): Mac Only


Multichannel Audio Regions and Plug-ins 

The exact behavior of third party plug-ins when using multichannel files can vary, depending on 
the number of channels supported by the plug-in.


If a plug-in does not support the audio channel layout of the document, a red exclamation 
mark is displayed next to the plug-in name. In this case, the application is permissive with the 
plug-in but it might result in artifacts such as unprocessed channels or a de-phasing of the 
channels.





Insert 
Click on the “+” button to show the Plug-in List Window and add a new plug-in.


	 	 Plug-in Lists: Displays plug-ins that have been scanned for use in the “Plug-in 
section”.


	 	 Manage: Enable different plug-in formats for use in the TS2. The enabled format to be 
scanned.


	 	 Show: Select your plug-in format view in the listing.


	 	 You can delete any plug-ins in any format you don’t want to appear in the plug-in list.
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Delete

Click on the “x” to the right of the selected plug-in.


Change Order 
Click and drag up or down the Black right icon of the selected plug-in.


View 
Click on the Plug-in Name to view the GUI.


Scan and View 
You can select a specific format to scan or view.


In the Plug-in List you can delete any of them, select the View type and Scan type, and Clear 
all plug-ins. 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Appendix


1. Key Commands


Mac Windows Function

CMD + Q CTRL + Q Quits the application

CMD + N CTRL + N Create a new Document

CMD + O CTRL + O Open a Document from file

CMD + S CTRL + S Save the current Document

SHIFT + CMD + S CTRL + SHIFT + S Save the current Document as a new file

CMD + W CTRL + W Close the current Document

SHIFT + CMD + C CTRL + SHIFT + C
Save the current Document with all 

associated files

SHIFT + CMD + E CTRL + SHIFT + E Export the current Document to an audio file

CMD + , CTRL + P Show the audio settings panel

SHIFT + CMD + M CTRL + SHIFT + M Toggle MIDI learn

CMD + Z CTRL + Z Undo last action
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SHIFT + CMD + Z CTRL + SHIFT + Z Redo last action

CMD + I CTRL + I Insert a set of region

Backspace Backspace Delete all selected regions

Delete Delete Delete all selected regions

CMD + X CTRL + X Cut all selected regions

CMD + C CTRL + C Copy all selected regions

CMD + V CTRL + V Paste the copied regions

CMD + E CTRL + E Split regions at cursor

Option + R Alt + R Activate or deactivate the ripple mode

Option + S Alt + S Activate or deactivate the snap mode

Spacebar Spacebar Start or stop the audio playback

CMD + L CTRL + L Enable or disable the loop audio playback

CMD + R CTRL + R Start or stop the audio recording

Q Q
Move the playhead to the end of the 

document

W W
Move the playhead to the start of the 

document
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SHIFT + Cursor Right
SHIFT + Cursor 

Right Move the playhead to the right

SHIFT + Cursor Lef
SHIFT + Cursor 

Lef Move the playhead the lef

Cursor Right Cursor Right Move the playhead to the next region limit

Cursor Lef Cursor Lef
Move the playhead to the previous region 

limit

SHIFT + I SHIFT + I
Move the playhead to the start of the 

selection

SHIFT + O SHIFT + O
Move the playhead to the end of the 

selection

CMD + A CTRL + A Select all regions

SHIFT + CMD + Cursor 
Right

CTRL + SHIFT + 
Cursor Right Move the edge of the selection to the right

SHIFT + CMD + Cursor 
Lef

CTRL + SHIFT + 
Cursor Lef Move the edge of the selection to the lef

CMD + Cursor Right
CTRL + Cursor 

Right
Move the edge of the selection to the next 

region limit

CMD + Cursor Lef CTRL + Cursor Lef
Move the edge of the selection to the 

previous region limit

I I Reset the time selection at play head position

O O End the time selection at play head position

CMD + = CTRL + = Decrease the time zoom

CMD + - CTRL + - Increase the time zoom
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CMD + Ctrl + F N/A
Switch back and forth between

Full Screen Mode (macOS only)

CMD + T CTRL + T
“Train Regions” (new with v2.1.2) 

Removes silence between selected regions
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